Nozzles for use in Corel ® Painter ™

Introduction
Thanks for the purchase (and / or interest) of the nozzles from graphicxtras.com.

Andrew

Installation of nozzles set

zip/hgx: Please extract the nozzles files (RIFF) to a sub folder of Painter (a suggested location being nozzles). Expand the zip
file using a zip utility on the PC and perhaps Stuffit Expander on the MAC

CD: Please select and drag/copy the nozzles files (RIFF) from the CD to the hard disk and place in a sub folder of Painter ™

Installation folder for nozzles
Please place the RIFF files in the following folders. Depends on the version of Painter and OS.

With XP, C:\program files\...\painter\nozzles (this folder might or might not exist, it is only a suggested location for the RIF
nozzles files)

For X, place the RIFF files in the Corel ® Painter ™ X resources 'Painter nozzles' folder. This is a change from previous
versions of Painter ™ and it appears other resources should also be placed in this location in grains etc (this may change with
later versions). Earlier versions had no initial source folder for the nozzles

On OS X, HD:applications:...Painter...:nozzles or in the case of Painter X, Painter nozzles folder

On Vista, because of security reasons, you might prefer to place the Painter nozzles (*.RIF) into the user account i.e.
User\Documents\Painter nozzles.
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Serial numbers

Please store any serial numbers for reference and for any future updates or replacement CDs (there are multiple serials
because originally the product was available in multiple sets)



Loading nozzles in Painter ™ in recent versions

1) Once you expanded the files and placed them in the sub folder of Painter
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2) Go to the Painter toolbox
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3) Click the nozzles icon at the bottom of the toolbox as displayed above

4) Click the right arrow at the top right of the palette

5) Expand the menu

6) Select the load nozzle option

7) Browse to the Painter nozzles folder (created earlier) and select a RIF file

8) Once loaded, the image hose now will use the selected RIF / nozzle file



'

-Jﬂ Select Image
Lookin: i/ Nozzles 01 - Miced ~ O F @
== Mame Date modified Type
he S Monp1 140 05/11/2002 17:48 Painter document
Recent Places oy 139 05/11/200217:47  Painter document
l f'”' SMNO01_138 051172002 17:46 Painter document
-;}Tﬁ SMO1_137 05/11/2002 17:45 Painter document
Desktop f'#' SN Type: Painter document T:45 Painter document
- o ¥ SpO| Size: 127 KB 7:i4 Painter document
']‘-J 188 cpp Date modified: 05/11/200217:45 §7.43 Painter document
Andrew S SN0 133 05/11,/2002 17:42 Painter document
_ .| SM01_132 05/11/2002 1741 Painter document
LLH W 5ND1_131 051172002 17:40 Painter document
Computer A SMN01_130 051172002 17:40 Painter document
_ . SMO1_129 05,/11/2002 17:40 Painter document
L_‘ ™ sno1 128 05711/200217:39 Painter document
-y, 4| i |
Metwork
File name: SMNO1_137 -
Files of type: | RIFF Files {"RIF)
[ Open rumbered Files

4

Cancel

1

300 by 300 Pixels
52 K RIFF

Load nozzles in earlier versions of Painter

Earlier versions had a slightly different way of loading nozzles

1) Go to the brushes palette
2) Select the nozzle menu
3) Select the load nozzle command (or Ctl-L)

4) Browse to required nozzle
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Add to nozzles library NZL

You might prefer to add the nozzles to a nozzles NZL library (please consult the Painter documentation for the instructions).

Most of the features of the nozzles now make the nozzles library feature redundant, though libraries are always useful for
project work (nozzles libraries tend to take up a lot of disk space).
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With Painter IX / X

1) Go to the toolbox

2) Select the nozzles icon

3) Expand to see all the current nozzles in the nozzles library

4) Go to the top right menu

5) Load nozzle command

6) Select nozzle

7) Go to the top right menu again

8) Select the add add to nozzle command

9) Dialog will appear requesting a name for the nozzle (select the current one or give it a better name)
10) Click OK

11) Expand nozzle library palette and you will see the nozzle has been added to the current library

You may wish to move the nozzles between libraries or create a new library, use the nozzle mover command for this via the
nozzles palette. Move the newly created nozzle to a new library and save that as a NZL library

Nozzles backup

I would suggest making a backup of all the RIFF files onto CD. Working with the nozzles may corrupt the files and they may
fail to open. Same with any pattern or grain files. A backup set can be sent but there will be some additional cost for postage
and packaging

Browser (in earlier versions of Painter)

There used to be a browser in Painter (certainly in version 5 6 7 etc but now, sadly, there is no browser).

Opening the nozzles folder, you would see an additional button 'browse’
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Nozzles thumbnails

A number of JPGs and GIFs have been included to display all the nozzles in the collection. The nozzles thumbnails can also be
seen via the Painter browser (though this requires the PIX file on the PC)

Nozzles use
Nozzles can be used in many different ways: please consult the documentation for further details. Nozzles can be used as

paint brushes or sprays or used in auto clone to create backgrounds or textures; or nozzles can be captured and used as a
brush source and more. Please check documentation on the web and on sites such as the Painter Artistry site.

Royalty-free

All the nozzles in this collection are royalty-free. For use in commercial and hobby work

Export

The nozzles can also be exported using the file format TIFF (save the alpha channel) to TUB format for use in Paint Shop Pro
™ or for use in Propeller Paint Engine ™ or in Image sprays in Corel Photo-Paint ™ (RIFF format can be used directly in PP)

1) Open the nozzle file (*.RIF or RIFF)

2) Select > Load selection

3) Apply effects or paint additional or remove elements of the nozzle
4) file > save as ...

5) Select TIFF from drop down (*.tif)

6) Select the save alpha to ON

7) Save file

8) Open in other application such as Photoshop or Paint Shop Pro (and then use the export to TUB format)

Installation issues

If you have problems installing or using this product, please e-mail our tech support at support@graphicxtras.com
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Comments
If you have any suggestions to how we can improve our products or manual, or if there is something that is hard to

understand or badly stated, please contact us and we will try to correct any errors or misunderstandings in the next release of
the manual. It is always great to hear your feedback.

System requirements

Applications supported - Corel ® Painter ™ 5-8 IX I1X.5 X Windows 98, NT, ME, XP, NT, Vista and MAC OS X.
The nozzles will not work in Painter Essentials

Other applications

Painter3aD ™

Minimum requirements

At least 64MB of memory, though some operations might require a lot more.

Trademarks

The nozzles were designed by Andrew Buckle, and copyright 1999-2005 Abneil Software Ltd / Andrew Buckle and Abneil
Software Itd. Documentation (c) 1999-2008 Andrew Buckle

All products mentioned in this manual are trademarked or probably trademarked by their respective owners. lllustrator and
Photoshop and Adobe and After Effects are registered trademarks of Adobe Systems Incorporated.

Corel is registered trademark of Corel Corporation and Painter is registered trademark or trademark of Corel Corporation.
We have no connection whatsoever with Corel

Company address

Telephone: UK 01622 688 375

http://www.graphicxtras.com

support@graphicxtras.com

Other items available

There are a number of other items that might be of use in Painter such as our plugins series (pc) and patterns and grains
Hints and tips

Nozzles and auto clone

Automatic nozzles placement for great patterns and backgrounds. Auto clone has now been superseded by auto painting

Blobs and nozzles

Use as a source for blobs (select the nozzle and copy into the pasteboard and use as a blob source). The blobs tool is great
for truly weird and wonderful blobby and abstract and gooey designs in Painter
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1) Open riff file

2) Select > load selection

3) Edit > copy

4) Effects > Esoterica > Blobs...

5) Set the number of blobs etc but most importantly, set the fill blobs option to 'Paste buffer’

6) Click OK



7) Re-apply etc
Capture nozzle / brush

Capture nozzle/brush to create new brush dab. Use the capture brush feature (capture dab) and then apply a variety of
different settings to create a new unique brush stroke. The nozzle captured brush dab can be used in many different brushes
such as pastels, crayons, charcoal etc

-

Nozzles stream

Apply nozzles as a continuous stream of paint using the spacing setting for the nozzle
Splatters and nozzles
Use nozzles as brush dab splatters, use the jitter feature to spread the nozzles

Effects

Combine nozzles and effects, apply a nozzle brush stroke, apply effect such as blur, apply more nozzles and interleave the
effects and nozzles, great way of adding unusual depth to illustrations



Blending modes / layers

Use nozzles on layers and apply with different blending modes and effects and drop shadows
1) Select the nozzle / image hose brush

2) Go to the nozzle icon in painter toolbox

3) Display nozzle palette

4) Go to top right menu and load nozzle

5) Layers > New Layer

6) Go to the layers palette

5) Select the layer

6) De-select the preserve transparency (if on, you will see nothing)

7) Apply nozzle to the current selected layer

8) If you want to add a shadow, go to the effects menu > objects > create drop shadow and apply

9) Repeat as required



Warp

Use a nozzle/image floater and warp command to create wonderful nozzle distortions. Save the nozzle using the drop and
select (perhaps with some tweaking to improve the alpha channel) and save as a RIFF and reload as nozzle for a warped
nozzle effect.

Layered

Paint nozzles (varying the scaling) on top of nozzles and re-save the nozzles in Painter ™

Text fills and nozzles

Nozzles are great as fills for text. Type the text and use the drop and select (layers menu). Fill the text with the nozzles. Use
the selection to copy and paste to create copies of the nozzle text. Apply effects, drop shadows. Apply floater effects to the

nozzles (to do this, group any additional effects such as drop shadow and collapse the layer and then apply the floater layer
effects such as bevel and burn)



Grains and patterns

Nozzles can be excellent sources for grains and patterns. Either use the single dab or apply multiple dabs (using the define as
a pattern feature) and create a new pattern using the nozzle. Save the pattern in the patterns palette (or grains palette)

Clone

Nozzles can, via patterns, be used as an excellent clone source and a source for numerous effects such as glass distortions.



Looks
Looks / nozzles are great combinations for superb hi-impact repeatable creative effects. Access via the looks palette in Painter

Overlay

Nozzles can be used as overlays via floaters or apply multiple floaters and change the composite methods to create weird
color scheme nozzle display

1) Open nozzle file

2) Select > load selection

3) Drag the selected nozzle to the 'image portfolio' palette using the layer adjuster tool
4) A 'save image dialiog" will appear, enter a name or just use the layer name

5) Close RIFF (do not save during the close or you will lose the nozzle RIFF)

6) Open new document

7) Go to the image portfolio palette

8) Select the nozzle floater and drag to the new document, repeat as required.

9) Effects > Orientation to re-size the floater (free transform etc)

10) Apply effects to the floater as normal
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3D

The nozzles also work in Painter 3D - opening up a wide range of 3D imagery for the nozzles. Superb for textures and 3D
applications.

Straight line

Use the straight line brush option with the nozzles to create frame designs
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Align to path

Create a path (such as spiral or frame or abstract design), select the nozzle brush and set the brush stroke to freehand and
‘align to path' option and apply the nozzle to the path to create a spiral or frame out of nozzles. Useful to be able to see the
path so it is best to set the path stroke color to something other than the background (in the example, red has been chosen).
Apply the nozzle anywhere on the path. The nozzle will not be ‘painted’ anywhere other than on the path.
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Nozzles as a floater

Open the nozzle file and drag into the floater palette and use as a floater (now called image portfolio). Go to the window



menu and select the image portfolio. Once in the image portfolio, the floater / nozzle can be added as a standard image /
layer. Various layer effects can be applied like burn

Adjust color

Paint a few nozzles. Adjust color via the effects menu adjust colors command. Paint more nozzles, creating a colorful overlay

Stroke

The nozzle can be applied as a user brush stroke or you can save a stroke and then playback the stroke on a single click (or



multiple clicks) You can also use the pre-built brush strokes such as scribble or hatch or your own recorded nozzle brush
strokes.

Grains

Open a nozzle, apply a grain or image luminance, save, and use the paper-tinged nozzle as a new brush strokes
Spacing

Use different spacing settings to create a tube of paint or a splatter spray of nozzles. The spacing is changed via the spacing

palette. The spacing can be set at 1% to 200% (though beyond via the entry box) The minimum spacing can also be set and
damping.



Grid and nozzles

Use the image hose/brush grid option to paint a grid of nozzles

XML

Use the capture dab and capture a nozzle and use for charcoal or oil. Save the brush dab and save the brush variant, modify
the XML code to create stunning new nozzle brushes

Photo-Paint ™

The nozzles can be read in Corel ® Photo-Paint ™ and via TIFF in others

Nozzles scaling

Use the nozzles scaling setting via the nozzles palette to re-scale the nozzle.

1) Go to the toolbox

2) Select the nozzles icon

3) Display nozzles palette

4) Load nozzle command via top right menu

5) Go to the top right menu again

6) Select ‘Nozzle scale' option

7) Displays the current scale (sometimes for some weird reason, 102% on newly added nozzle)

8) Set the new scale as required
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8) Apply the new nozzle (scaled) using the image hose as usual

Rank

The nozzles from graphicxtras.com are generally just a single cell nozzle. Complex nozzles can be created with multiple cells
and differing rank (selection) of nozzles from the RIFF file. Go to the image hose palette and set the rank for the hose:

random selection, pressure, etc
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Variants

You can also create your own variant hose brushes to add to the brush palette.

Variants / expression

Hose variants also can be developed (even using a mouse instead of a pen) using information from expression palette.

Frame and nozzles

Another way to create an instant frame is to use a selection and select most of the image, invert the select and paint or use

the auto clone option
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Sprays and Painter nozzles
Apply nozzles as sprays
Opacity

Lower the opacity of the nozzle and apply to create a blurry nozzles brush stroke

Grain / nozzle brush palette



Lower the grain setting in the general brush strokes palette to change the nozzle into a brush dab using the current
foreground color. If the current foreground is blue, the nozzle will be a blue stamp. This can be combined with expression /
grain to modify the color / original nozzle combination. Sadly, the color cannot use color variability or other color settings
such as clone color to change the color of the nozzles.

The grain can be modified via the source setting in the expression. Set a clone source and set the grain to 100% and then
apply the nozzles using the expression source setting. The color of the nozzle is not changed but the impression of the clone
source can be created using nozzles. This can also be used in auto painting: the nozzles scribble etc are set to the underlying
cloned source.

Auto Painting

Superseding the autoclone, use the nozzles in Auto Painting. Use to create many different and interesting brush strokes,
textures, overlays, frame designs and more

1) Select a nozzle

2) Go to the auto painting palette

3) Select stroke such as scribble large or hatch
4) Set brush size, rotation, randomness

5) Click the play button



Rank 1: |:

Rank z:

Rank 3: |:

b Airbrush
b \Water
b Ligquid Ink

L]

Shyle

| MNone = |
Edge EFfect

Mone - |

Arnourt [T 5 |

Arnount By 5| 0% |

Direction: [l Smart Blur

Reset Apply

b Digital W4

Stroke

Quick Clane

Scribble

|
.

Randomness (IS =] 0% |

Pressure ]| 38%
Length [EEA——H| 75% |

Rakation [SHN ]
Friizh Siza m@




	Local Disk
	Nozzles notes


